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Use this step-by-step guide in 
conjunction with the AdvancedMD 
Help Files for complete details 
about how to accomplish the 
below PI Measures.

MIPS Performance
Categories for 2019

Objectives Required Measures Bonus Maximum Points

Protect Patient Health Information Security Risk Analysis 0

ePrescribing ePrescribing* 10

Query of PDMP 5

Verify Opioid
Treatment Agreement 5

Health Information Exchange Support Electronic Referral Loops by 
Sending Health Information* 20

Support Electronic Referral Loops by Receiving & 
Incorporating Health Information* 20

Provider to Patient Exchange Provide Patient Access to Their Health Information 40

Public Health & Clinical 
Data Exchange

(Report to two different pubic health agencies or 
clinical data registries)

Immunization Registry Reporting*

10

Syndromic Surveillance Reporting*

Electronic Case Reporting *

Public Health Registry Reporting*

Clinical Data Registry Reporting*

* Exclusions Available

The MIPS eligible clinician must report on all of the required measures across all of the objectives in order to 
earn any score at all. Failure to report any required measure, unless an exclusion is claimed, will result in a PI 
score of 0. 



Measure: Security Risk Analysis 

Objective: Protect Patient Health Information

Conduct or review a security risk analysis in accordance with the requirements in 45 CFR 164.308(a)(1), including addressing 
the security (to include encryption) of ePHI data created or maintained by certified EHR technology in accordance with 
requirements in 45 CFR164.312(a)(2)(iv) and 45 CFR 164.306(d)(3) and implement security updates as necessary and correct 
identified security deficiencies as part of the MIPS eligible clinician’s risk management process.

Scoring Information - Required (0 points)

Solution: Complete a Risk Analysis and maintain in your office a signed and dated copy along with a copy of AdvancedMD’s 
Help Files on System Security and HIPAA Privacy and Security Rules by HITECH.

Use these helpful links:
Small Practice Security Guide 
Healthit.gov - Security Risk Assessment
Healthit.gov - Sample Seven-Step Approach for Implementing a Security Management Process
Management Process AHIMA - Information Security Overview (2014 Update)
Privacy and Security Guide

AdvancedMD Step by Step
Using information from the links above, complete and document a Risk Analysis for your office—sign, date and store it.

Print a copy of the AdvancedMD Help Files for System Security and HIPAA Privacy and Security Rules by HITECH
 Help > Contents > Search Security > AdvancedMD System Security Documentation page (print this)
 Help > Contents > Search Security > HIPAA Privacy and Security Rules by HITECH (print this)

MIPS eligible clinician must submit a YES that they have completed the SRA measure during the calendar year in which the 
MIPS performance period occured.

Note: This Measure will not appear on AdvancedMD reports—this will be a Yes/No question on attestation.

https://www.healthit.gov/sites/default/files/smallpracticesecurityguide-1.pdf
https://www.healthit.gov/providers-professionals/security-risk-assessment-tool
https://www.healthit.gov/sites/default/files/pdf/privacy/privacy-and-security-guide-chapter-6.pdf
https://www.healthit.gov/sites/default/files/pdf/privacy/privacy-and-security-guide-chapter-2.pdf
https://www.healthit.gov/sites/default/files/pdf/privacy/privacy-and-security-guide.pdf


Measure: e-Prescribing 

Objective: e-Prescribing

At least one permissible prescription written by the MIPS eligible clinician is queried for a drug formulary and transmitted 
electronically using certified EHR technology.

Scoring Information - Maximum Points - 10 points based on performance rate

Exclusion: Any MIPS eligible clinician who writes fewer than 100 permissible prescriptions during the performance period. If an 
exclusion is claimed, the 10 points for the e-Prescribing measure will be redistributed equally among the HIE measures.

Solution: Using AdvancedMD e-Prescribing, the drug formulary is enabled and the eligible clinician signs and eSends 
permissible prescriptions.

The calculation for this Measure looks at prescriptions written and sent electronically during the reporting period.

AdvancedMD Step by Step

Using one of the e-Prescribing chart tools 

Enter details for prescription and click Sign

Opens the Confirm Prescriptions screen – click Sign 

Click eSend  or click 

Formulary Check – Within AdvancedMD, the system is defaulted to have the formulary check enabled. To meet the 
requirement, the patient must have a current, active formulary plan based on the carrier entered into the Patient’s Insurance tab 
in the PM.

Additional Tips:

When entering medications into a patient’s chart that were not prescribed by your provider, be sure to choose Other 
Provider and adjust the dates, if applicable, so these won’t appear to have been entered but not eSent.

Permissible medications are a DEA class of (0), additional classes if provider has EPCS permissions enabled.

Formulary Check – Ensure the User Preferences | Rx | Turn off Formulary Lookup for Favorites Searches so Search will be 
faster and checkbox is empty.

For additional details about Prescriptions – check out the Prescriptions section of the EHR Help Files.

Bonuses (Optional) – AdvancedMD is not currently developed to capture or report on the two e-Prescribing bonus measures. 
As PDMP programs vary by state, CMS plans to issue further guidance regarding these measures. 

Measure: Query of Prescription Drug Monitoring Program (PDMP) 5 Points

For at least one Schedule II opioid electronically prescribed using CEHRT during the performance period, the MIPS eligible 
clinician uses data from CEHRT to conduct a query of a PDMP for prescription drug history, except where prohibited and in 
accordance with applicable law. 

The query of the PDMP for prescription drug history must be conducted prior to the electronic transmission of the Schedule II 
opioid prescription. MIPS eligible clinicians would have flexibility to query the PDMP using CEHRT in any manner allowed under 
their State law. 

Solution: Participants who prescribe EPCS may follow CMS’s guidance from the QPP Final Rule



“We understand that many clinician systems may not have the ability to capture the number of PDMP queries in an automated fashion, 
and that these clinicians may need to capture the data and calculate the measure manually. The intent of the measure is to identify 
multiple provider episodes (physician shopping), prescriptions of dangerous combinations of drugs, prescribing rates and controlled 
substances prescribed in high quantities”. 

“Many MIPS eligible clinicians will likely need to manually enter the data into CEHRT to document the completion of the query of the 
PDMP action. In addition, some MIPS eligible clinicians may also need to conduct manual calculation of the measure.”

 “If you choose to submit data for CY 2019 for the Query of PDMP measure, you will submit your numerator and denominator”.

 Measure: Verify Opioid Treatment Agreement 5 Points 

For at least one unique patient for whom a Schedule II opioid was electronically prescribed by the MIPS eligible clinician using CEHRT 
during the performance period, if the total duration of the patient’s Schedule II opioid prescriptions is at least 30 cumulative days within 
a 6-month look-back period, the MIPS eligible clinician seeks to identify the existence of a signed opioid treatment agreement and 
incorporates it into the patient’s electronic health record using CEHRT. 

Solution: Participants who prescribe EPCS may follow CMS’s guidance from the QPP Final Rule

“We leave it to the discretion of the MIPS eligible clinician to determine what is considered an opioid treatment agreement and how to 
capture this in their CEHRT.”



Measure: Provide Patients Electronic Access to Their Health Information 

Objective: Provider to Patient Exchange

For at least one unique patient seen by the MIPS eligible clinician: (1) The patient is provided timely access to view online, 
download, and transmit his or her health information; and (2) The MIPS eligible clinician ensures the patient’s health 
information is available for the patient to access using any application of their choice that is configured to meet the technical 
specifications of the Application Programming Interface (API) in the MIPS eligible clinician’s certified electronic health record 
technology (CEHRT). 

Scoring Information - Maximum Points - 40 points based on performance rate

Exclusions: None

Solution: Using AdvancedMD’s Patient Portal, your patients have access to their health information 24/7 in real-time on demand 
and have the ability to view, download and transmit their information to a third party. As your 2015 CEHRT EHR vendor, we have 
met the Application Access certification criteria and have made APIs available to developers that wish to build applications that 
allow a patient to access their data. See the AdvancedMD Patient APIs website for details at https://developer.advancedmd.
com/index

AdvancedMD Step by Step 

Setup the Patient Portal for your office: PM | Utilities | Portal Act Maintenance | Patient Portal Designer.
  
Enter the patient’s email into the Patient Demographics screen. 

Create Patient Portal accounts for your patients in the Patient screen. 
 
Invite your patients to connect with you through the portal. 
 

Encourage your patients to check their email, find the invitationand click  
on the link to access the portal. View the ConfiguringPatient Portal training 
video in the Video Training Libraryfor more details.

Additional Tips:
In System Defaults (PM | Utilities | System Defaults | Patient Portal | View EHR 
Chart Items) you can control if your patients can see Notes, Lab Results, Images and Growth Charts in the Patient Portal.

To control access to specific chart items in the EHR – If the System Default is checked to Yes – these items allow you to 
override the Yes and uncheck the Patient Viewable checkbox so that patient won’t see that specific item in the portal.

Some offices help their patients access the portal using the patient’s smartphone while still in the office. These offices then 
know that some patients have accessed their patient portal and it shows patients how easy using the portal can be.

It is suggested that you setup a test patient with an account and test all parts of this process with that test patient before going 
live with this feature.

If you wish to add a link to the patient portal for your office key to your office’s website – replace the xxxxxx in this address with 
your office key’s 6 digits: https://patientportal.advancedmd.com/Account/LogOn?lk=xxxxxx

For additional details about setting up the Patient Portal – refer to that section of the PM Help Files.

The Provide Patients Electronic Access to Their Health Information measure does not require that patients actually access 
their information.

CMS defines “timely” as within 4 business days of the information being available to the MIPS eligible clinician.

https://developer.advancedmd.com/index
https://developer.advancedmd.com/index


Measure: Support Electronic Referral Loops by Sending Health Information 

Objective: Health Information Exchange

The MIPS eligible clinician that transitions or refers their patient to another setting of care or health care provider (1) uses CEHRT 
to create a summary of care record; and (2) electronically transmits such summary to a receiving health care clinician for at least 
one transition of care or referral.

Scoring Information - Maximum Points - 20 points based on performance rate

Exclusion: Any MIPS eligible clinician who transfers a patient to another setting or refers a patient fewer than 100 times during 
the performance period. When claimed, the 20 points will be redistributed. However, CMS has not announced where the points 
will be distributed to. 

Solution: Use the Print/Send Summary/Referral command from a signed note or the Outbound CIE Tool to generate a Referral/
Transition of Care record and electronically transmit to another provider of care via Direct Messaging.

AdvancedMD Step by Step 

When referring a patient, from the signed note, click on the 
Print/Send Summary/Referral | Referral/Transition of Care. 
 
This opens the Generate Outbound Clinical Document screen with that patient chosen.
Search for and choose the clinician to whom you wish to send the CIE document.
Select Referral/Transition of Care from the CDA Type dropdown.
Enter the date range and reason for Referral/Visit.
The CDA Edit pane opens – click on a heading to open the drop-down for that section to choose which data to include/exclude, 
if applicable.

Once any editing is complete, click Finish and the Clinical Document preview opens.

You can edit these sections of the CIE and choose which information you want to include: Allergies*, Medication*s, Problems 
List*, Encounters, Procedure List, Immunization, Functional Status, Mental Status, Assessments, Goals, Health Concerns, Plan of 
Treatment, Social History, Patients Instructions, Lab Results, Medical Equipment, Vital Signs, Care Team Information. * Required 
field for the SOC record. 

Review the information and then click Send – the CIE is electronically sent to the clinician.

Outbound CIE documents are saved to the patient’s chart – labeled Outbound CIE.  

Go to Reports > eSend Status > CIE Outbound to 
check the status of the transmission.



Additional Tips:

Clinicians must have a Direct Messaging address in order to send or receive CIE documents – contact support if you need to be 
setup with a Direct Messaging address.

AdvancedMD is contracted with SureScripts as its Health Information Service Provider (HISPS).

If clinicians you work with do not have Direct Messaging addresses yet – encourage them to contact their EHR vendor and get 
signed up for this service.

In the Help Files for Health Information Exchange – the Data Definitions section lists the data elements required in a Summary 
of Care Record:
 

Fields include Allergies, Medications, Problem Lists, Encounters, Procedures, Immunizations, Functional Status, Cognitive 
Status, Assessments, Goals, Health Concerns, Plan of Treatment, Social History, Patient Instructions, Lab Results, Medical 
Equipment (Implantable Devices), Vital Signs, Care Team Information, and Reason for Referral.

To ensure that the data entered into note fields displays in the appropriate section of the CIE document these fields   
are pre-coded in content from AdvancedMD’s template library. See Help Files for Template Field Control Properties for  
additional information for setting up Codesets and codes for any fields you are creating from scratch, which should be   
included in one of the above sections of a CIE document.

For additional details about setting up, sending or receiving CIEs – refer to that section of the EHR Help Files.



Measure: Support Electronic Referral Loops by 
Receiving & Incorporating Health Information

Objective: Health Information Exchange

For at least one electronic summary of care record received for patient encounters during the performance period for which a 
MIPS eligible clinician was the receiving party of a transition of care or referral, or for patient encounters during the performance 
period in which the MIPS eligible clinician has never before encountered the patient, the MIPS eligible clinician conducts clinical 
information reconciliation for medication, medication allergy, and current problem list.

Scoring Information - Maximum Points - 20 points based on performance rate

Exclusion: (1) Any MIPS eligible clinician who is unable to implement the measure for a MIPS performance period in 2019  
would be excluded from this measure. (2) Any MIPS eligible clinician who receives fewer than 100 transitions of care or referrals 
or has fewer than 100 encounters with patients never before encountered during the performance period would be excluded 
from this measure. If an exclusion is claimed, the 20 points will be redistributed to the other HIE measure. 

AdvancedMD Step by Step 

Setup Transition of Care Appointment Type – PM > Master Files > Appointments > Appointment Types. 
Check the Transition of Care checkbox for any applicable appointment types. The Transition of Care 
check box can also be checked at the time of making the appointment.

Contact the Referring Providers Office to request the patient’s Summary of Care. 
Select whether the SOC is Available or Unavailable. 

Marking the SOC Unavaliable will remove the patient from the measure denominator. 

If available, upload the patient’s SOC directly to the encounter. Whether it’s a secure email, inbound CIE or secure fax all 
incoming CIE files need to be directly linked to the patient’s encounter in order to be counted in the measure. Once an Inbound 
CIE has been imported into the patient’s chart use the Chart Maintenance tool to link it directly to the encounter. 

When uploading the SOC prior to the patient visit, link the SOC directly to the encounter in the patient’s chart: From the 
Encounter/Charge Slip > Add Linked > Upload File > Select Summary of Care Document Type > Upload File. If uploading the 
same day as the patient visit, ensure  that your EHR Chart User Preference is set to auto-link chart items and document uploads. 
The Transition of Care appointment type will display the clinical reconciliation boxes on the info tab.

If Summary of Care Document Type is not available, go to Admin > System 
Setup > Lookup Lists > Documents Type and create an Active Summary of 
Care Document Type. 

The Summary of Care will be saved in the Patients Document Card and linked to the Encounter in the Encounters Card. 

Once the SOC is reviewed and reconciled, to mark that Clinical Information Reconciliation was completed, on the Visits Note 
Info Tab, select the Medications, Allergies and Problems Reviewed check boxes and save the note.  

Additional Tips:

The use of direct messaging is not required to fulfill this measure. The intent is to promote and facilitate a wide range of options 
for the transmission of an electronic summary of care document. Examples of acceptable transmission methods include secure 
email, Health Information Service Provider (HISP), query-based exchange or use of third party HIE.



Measure: Immunization Registry Reporting

Objective: Public Health and Clinical Data Exchange

The MIPS eligible clinician is in active engagement with a public health agency to submit immunization data and receive 
immunization forecasts and histories from the public health immunization registry/immunization information system.

Scoring Information - Maximum Points - 10 points

The MIPS eligible clinician will receive the full 10 points for reporting two “yes” responses, or for submitting a “yes” for one 
measure and claiming an exclusion for another. If there are no “yes” responses and two exclusions are claimed, the 10 points 
will be redistributed to the Provide Patients Electronic Access to Their Health Information measure.

Exclusion: Any MIPS eligible clinician meeting one or more of the following criteria may be excluded from the Immunization 
Registry Reporting measure if the MIPS eligible clinician:

1. Does not administer any immunizations to any of the populations for which data is collected by its jurisdiction’s 
immunization registry or immunization information system during the performance period.

2. Operates in a jurisdiction for which no immunization registry or immunization information system is capable of 
accepting the specific standards required to meet the CEHRT definition at the start of the performance period.

3. Operates in a jurisdiction where no immunization registry or immunization information system has declared readiness 
to receive immunization data as of 6 months prior to the start of the performance period.

Solution: Utilize the Health Agency Module to transmit immunization. To facilitate electronic transmission to registries 1) 
Contact your state registries to declare your intent and to determine their readiness, 2) Contact AdvancedMD to setup registry 
connection.

AdvancedMD Step by Step 

Contact the public health agency/agencies with which you submit immunization.

Declare your intent to setup an HIE Info Exchange (some states are NOT accepting electronic data yet).

If your state is not yet accepting electronic data – it is your responsibility to keep in touch with them to know as soon 
as that changes.

Contact AdvancedMD to setup registry connection.

Setup the immunizations that you administer in your office – 
 PM | Master Files | Transaction Codes | Charge Codes
  Enter the appropriate CVX codes into the immunization CPT codes
 
 EHR | Admin | System Setup | Immunizations
  Enter Charge Codes, CVX Codes, MVX Codes, dosing, schedule for immunizations you administer
  Record Immunizations administered in your office
 
 EHR | Patient’s Chart – use Immunization Chart tool 

Additional Tips:

The test file process goes better when you have captured at least a month of test information.

For additional details about setting up and using the Immunization chart tool – refer to that section of the EHR Help Files.

The measures under the Public Health and Clinical Data Exchange objective are reported using “yes or no” responses.



Measure: Syndromic Surveillance Reporting

Objective: Public Health and Clinical Data Exchange

The MIPS eligible clinician is in active engagement with a public health agency to submit syndromic surveillance data from a 
non-urgent care setting.

Scoring Information - Maximum Points - 10 points

The MIPS eligible clinician will receive the full 10 points for reporting two “yes” responses, or for submitting a “yes” for one 
measure and claiming an exclusion for another. If there are no “yes” responses and two exclusions are claimed, the 10 points 
will be redistributed to the Provide Patients Electronic Access to Their Health Information measure.

Exclusion: Any MIPS eligible clinician meeting one or more of the following criteria may be excluded from the Syndromic 
Surveillance Reporting measure if the MIPS eligible clinician:

1.   Is not in a category of health care providers from which ambulatory syndromic surveillance data is collected by their 
jurisdiction’s syndromic surveillance system.

2.   Operates in a jurisdiction for which no public health agency is capable of receiving electronic syndromic surveillance 
data in the specific standards required to meet the CEHRT definition at the start of the performance period.

3.   Operates in a jurisdiction where no public health agency has declared readiness to receive syndromic surveillance 
data from MIPS.

 
Note: The ability for any practice to setup an interface for Syndromic Surveillance is dependent on your state’s ability to 
accept the data.  The vast majority of states DO NOT accept syndromic data from eligible providers.  You should contact your 
state about the syndromic surveillance program, including on-boarding and determining if you are eligible for this program. 
If you want to setup a syndromic surveillance interface, please reach out to AdvancedMD Client Services Support for more 
information, including cost, on registering your practice.
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We suggest running PI reports on a regular basis so you’ll know how you’re doing with each Measure:

 PM Report Center > PI/Quality > Promoting Interoperability Summary or Detail. (PI/MIPS)

 Choose the clinician and the date range for the report.

The PI report is the big picture for all PI Measures. The Detail Report shows the specific patients who meet the criteria to 
be included in the Measure and those who don’t have the needed data in their chart. These reports can help you identify 
necessary workflow adjustments to capture more accurate data, and show which patients have any missing information 
within the reporting period.

http://www.advancedmd.com

